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Important information

PN WARNING

« Failure to follow the installation instructions shipped with the interactive flat panel could
result in personal injury and product damage which may not be covered by the warranty.

« Do not open or disassemble the interactive flat panel. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids the warranty.

« Do not stand (or allow children to stand) on a chair to touch the surface of the
interactive flat panel. Rather, mount the product at the appropriate height.

« To reduce the risk of fire or electric shock, do not expose the interactive flat panel to rain or
moisture.

« Ifthe interactive flat panel requires replacement parts, make sure the service technician
uses replacement parts specified by SMART Technologies or parts with the same
characteristics as the original.

o Ensure that any cables that cross the floor to the interactive flat panel are properly bundled
and marked to avoid a trip hazard.

« Do notinsert objects inside the cabinet ventilation holes, because they could touch
dangerous voltage points and cause electric shock, fire or product damage which may not
be covered by the warranty.

« Do not place any heavy objects on the power cable. Damage to the cable could cause
shock, fire or product damage which may not be covered by the warranty.

« Use only extension cords and outlets that can full accommodate the interactive flat panel’s
polarized plug.

« Use the power cable provided with the interactive flat panel. If a power cable is not
supplied, contact your supplier. Use only power cables that match the AC voltage of the
power outlet and that comply with your country’s safety standards.

o Ifthe glassis broken, do not touch the liquid crystal. To prevent injury, handle glass
fragments with care when disposing of them.

« Do not move or mount the interactive flat panel by connecting rope or wire to its handles.
The interactive flat panel is heavy, and failure of the rope, wire or handle could lead to

injury.

smarttech.com/kb/170814



IMPORTANT INFORMATION

Use only VESA®-approved mounting hardware.

Disconnect all of the interactive flat panel’s power cables from the wall outlet and seek
assistance from qualified service personnel if any of the following occur:

o The power cable or plug is damaged

o Liquid is spilled into the interactive flat panel
o Objects fall into the interactive flat panel

o The interactive flat panel is dropped

o Structural damage, such as cracking, occurs

o The interactive flat panel behaves unexpectedly when you follow operating
instructions

'y cauTioN

Before you clean the interactive flat panel’s screen, shut down or disconnect the computer.
Otherwise, you may scramble the desktop icons orinadvertently activate applications when
you wipe the screen.

Avoid setting up and using the interactive flat panel in an area with excessive levels of dust,
humidity and smoke.

Make sure an electrical socket is near the interactive flat panel and remains easily
accessible during use.

The external power supply must meet the Limited Power Source (LPS) requirements of
CSA/UL/IEC/EN 60950-1, when required.

The interactive flat panel should be used only with European TN and TT power distribution
systems.

It is not suitable for older, IT-type power distribution systems found in some European
countries. “This system (IT-type) is widely used isolated from earth, in some installations in
France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral
not distributed, at 230V line-to-line.” (IEC 60950:1999)

Contact qualified personnel if you're uncertain of the type of power system available where
you're installing the interactive flat panel.

The accessory slot is for use with SMART accessories only. The slot’s maximum available
poweris 60 W. The slot is not a limited power source. To reduce the risk of fire, ensure
accessories connecting to the slot satisfy the fire enclosure requirements of IEC 60950-1.

smarttech.com/kb/170814



IMPORTANT INFORMATION

o You must connect the USB cable that came with the interactive flat panel to a computer that

has a USB compliant interface and that bears the USB logo. In addition, the USB source
computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or
UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the
interactive flat panel.

IMPORTANT

The following are the power requirements for the interactive flat panel:

Model Power requirements
SBID8055i-G5-SMP 90V to 240V AC, 50Hz to 60 Hz, 140 W
SBID8065i-G5-SMP 100V to 240V AC, 50 Hz to 60 Hz, 210 W

For additional requirements and other information, refer to the interactive flat panel’s
specifications (see Resources for decision makers on page 9).

smarttech.com/kb/170814
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This chapterintroduces the SMART Board® 8000i-G5-SMP series interactive flat panel and this
guide.

About this guide

This guide explains how to set up and maintain the SMART Board 8000i-G5-SMP series interactive
flat panel. It includes the following information:

« How to mount the interactive flat panel
« How to connect power and devices

« How to set up the interactive flat panel
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CHAPTER1
WELCOME

« How to maintain the interactive flat panel for years of use
« How to troubleshoot issues with the interactive flat panel

In addition, this guide includes information on the interactive flat panel’s on-screen display menu
and remote management support.

This guide is intended for individuals who install and maintain interactive flat panels in their
organizations. Other documentation and resources are available for individuals who use
interactive flat panels.

About the interactive flat panel

The interactive flat panel features SMART’s proprietary DViT® (Digital Vision Touch) technology on
an LCD screen with e-LED backlight.

Models
The SMART Board 8000i-G5-SMP series interactive flat panels consists of two models:

« SMART Board 8055i-G5-SMP interactive flat panel (SBID8055i-G5-SMP)

« SMART Board 8065i-G5-SMP interactive flat panel (SBID8065i-G5-SMP)

Differences between these models are noted in this guide.

Specifications
Refer to the interactive flat panel’s specifications for detailed technical information, including
product dimensions and weights (see Resources for decision makers on page 9).

2 smarttech.com/kb/170814



CHAPTER1
WELCOME

Features

The interactive flat panel includes the following features:

Feature

Description

Touch support

You can do everything on the interactive flat panel that you can do
at your computer—open and close applications, meet with others,
create new documents or edit existing ones, visit websites, play
and manipulate videos, and so on—by touching the

interactive flat panel’s surface.

You can use an array of gestures within applications, including
panning, scaling, rotating and zooming in and out.

The interactive flat panel’s support for at least four simultaneous
touches enables you and other users to interact with objects on the
screen at the same time.

Writing and drawing
support

You can write over any application in digital ink using one of the
supplied pens, and then erase the digital ink using your palm or the
eraser on the pen.

You and another writer can write or draw digital ink on the screen at
the same time. The Pen iQ" feature enables you to assign different
ink appearances to each pen.

Audio support

The interactive flat panel includes integrated speakers for
presenting audio from connected input sources.

3 smarttech.com/kb/170814
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Components
The interactive flat panel consists of the following components:
SMART
1
2_
[ [ == TIj(T [ »= 13 ?J

I |

3 4 5
No. Name More information
Pictured
1 Screen Page 5
2 Cameras and reflective tape channel Page 5
3 Front control panel Page 5
4 Pen with eraser (x2) Page 6
5 Presence detection sensor Page 7
Not pictured
6 Speakers Page 7
7 Connector panel Page 16
8 Menu control panel Page 37
9 USB receptacle Page 18
10 Accessory slot and I/0O extension module Page 7
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Screen
The screen specifications vary by model:

Model Diagonal Width Height Aspect ratio

SBID8055i-G5-SMP 54 1/2" (138.4cm) 47 5/8" (121 cm) 26 3/4" (68 cm) 16:9

SBID8065i-G5-SMP 64 1/2" (163.9cm) 561/4" (142.8cm) 315/8"(80.4cm) 16:9

For information on cleaning the screen, see Cleaning the screen on page 25.

Cameras and reflective tape channel
Cameras in the corners of the screen track finger and pen positions across the display. The screen

is bordered by a channel that contains reflective tape.

For information on cleaning the camera windows and reflective tape, see Cleaning the screen on

page 25.

' cauTioN
+ Keep the reflective tape dry.

« Do notremove or damage the reflective tape.

IMPORTANT
« Do not attach adhesive notes or other items to the screen because they will interfere with

the cameras.

« Do not place anything in the reflective tape channel because it will interfere with the

cameras.

Front control panel
The front control panel contains the Standby, Input Select, Mute and volume control buttons.

4 5 3 4 5 No. Name
’ ‘ ! ! | 1 Standby button
} @ - :{b } 2 Input Select button
3 Mute button
4 Volume decrease
5 Volume increase

5 smarttech.com/kb/170814
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IMPORTANT

If there is a film over the front control panel, remove it before using the front control panel.

In normal operation, all buttons are white.

The Standby button also functions as an indicator light:

Indicator light Status Troubleshooting
Solid white Normal operation [N/A]
Off Not receiving power Confirm the interactive flat panel’s power

cable is connected to the power outlet
(see page 17).

Flick the power switch to the ON (l)
position (see page 19).

Solid amber DPMS (power management) Press the Standby button J to exit
mode DPMS mode.

Slowly flashing Standby mode Press the Standby button J to exit

amber Standby mode.

Flashing amber No USB connection from the Verify the connections to the room
connected computer computer (see page 17).

Slowly flashing SMART Board service not Ensure that SMART Product Drivers is

white running on the connected installed and that the SMART Board
computer service is running.

Pens with erasers
The interactive flat panel comes with two pens with erasers attached.

The interactive flat panel’s bottom frame includes magnetic holders for the pens. Removing a pen
from the holders activates it, and you can use it to draw or erase digital ink.

'Y cauTionN

When you return the pen to the magnetic holder, make sure it’'s centered in its holder to prevent
it from falling and potentially being damaged.
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Presence detection sensor

The interactive flat panel has a presence

detection sensor on its bottom frame that
can detect people up to 16' (5 m) away
when the interactive flat panelisin
Standby mode.

If the sensor detects people inthe room,
the interactive flat panel turns on and
displays a welcome screen. Touching the

screen activates the interactive flat panel. X

If the sensor doesn’t detect people inthe === ( °

room for a specified period, the
interactive flat panel returns to Standby mode.

NOTES

« Forinformation on cleaning the presence detection sensor, see Cleaning the presence
detection sensor on page 27.

« Presence detection settings can be changed with the on-screen display menu. For more
information, see Proximity on page 40.

Speakers
The interactive flat panel includes two 10 W integrated side-firing speakers.

You can connect external speakers if desired (see Connecting external speakers on page 18).

Accessory slot and 1/0 extension module

You can install the I/O extension module in the accessory slot located on the back of the
interactive flat panel. When installed, the 1/0O extension module enables you to connect the room
computer to the interactive flat panel using USB and HDMI® cables (see Connecting the

room computer on page 17).

'Y cauTtionN

The accessory slot is for use with SMART accessories only. The slot’s maximum available power
is 60 W. The slot is not a limited power source. To reduce the risk of fire, ensure accessories
connecting to the slot satisfy the fire enclosure requirements of IEC 60950-1.
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About SMART software

To take full advantage of the interactive flat panel’s features, you can install the following SMART
software on the computers connected to the interactive flat panel:

Software Description

SMART Product Drivers SMART Product Drivers enables connected computers to detect
input from the interactive flat panel.

SMART Ink™ SMART Ink enables you to write and draw in digital ink over
applications, files, folders, websites and any other open window on
your computer. When you write outside the open windows on your
computer, a SMART Ink Note appears, and you can write inside the
note.

When you open an application that has its own ink tools, you can
use the application’s ink tools to write in the content.

SMART Meeting Pro® SMART Meeting Pro software is designed to use with the
software interactive flat panel in a meeting room.
You can write or draw on a digital whiteboard, present content by
sharing your desktop and connect and collaborate with local or
remote participants using integrated conferencing software.

Resources for administrators

In addition to this guide, SMART provides a variety of other resources for administrators.

Training

The SMART training website (smarttech.com/trainingforbusiness) includes an extensive library of
training resources you can referto as you learn how to set up and maintain the

interactive flat panel.

Support center and knowledge base
The Support center (smarttech.com/support) contains a library of documents, including this guide,
and a knowledge base that you can search when troubleshooting issues.

8 smarttech.com/kb/170814
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Resources for others

SMART provides resources for decision makers, installers and users as well as administrators.

Resources for decision makers
Decision makers can refer to the specifications for detailed information about the
interactive flat panels.

Model Specifications
SBID8055i-G5-SMP smarttech.com/kb/170815
SBID8065i-G5-SMP smarttech.com/kb/170816

Resources for installers

Installers can refer to the installation instructions included with the interactive flat panel when
installing the product. A PDF version of these installation instructions is available for download from
smarttech.com/kb/170810.

Resources for users

Users can refer to the SMART Meeting Pro software Help for information about using the software
with the interactive flat panel. To open the Help, users can select Help > Contents in Whiteboard
mode.

9 smarttech.com/kb/170814
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Chapter 2

Mounting the interactive flat panel

Before mounting the interactive flat panel ... ... ... N
Mounting the interactive flat panel vertically ... ... e, 12
Choosing a loCatioN L il 12
Choosing a helght L.l 13

Mounting the interactive flat panel on a wall requires a team of professional installers.

This chapteris intended for installers. Installers should read this chapter along with the installation
instructions included with the interactive flat panel before they mount the interactive flat panel.

PN wWARNING

Improper mounting of the interactive flat panel can result in injury and product damage.

Before mounting the interactive flat panel

Remember the following before mounting the interactive flat panel:

« Review the environmental requirements in the interactive flat panel’s specifications (see
Resources for decision makers on page 9).

« Save all product packaging so that it’s available if you need to transport the
interactive flat panel. If the original packaging isn’t available, you can purchase new
packaging from your authorized SMART reseller (smarttech.com/where).

« Referto local building codes to ensure the wall can support the weight of the
interactive flat panel (specified in the following table) and mounting equipment.

Model Weight
SBID8055i-G5-SMP 106 Ib. (48.2 kg)
SBID8065i-G5-SMP 137 Ib. (62.2 kg)

o Use astandard VESA 400 mm x 400 mm mounting plate (not included)to mount the

interactive flat panel on a wall.

1 smarttech.com/kb/170814
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MOUNTING THE INTERACTIVE FLAT PANEL

« Use M8 screws to fasten the wall bracket.

Screw length 20mm +xmm <M8 <45 mm + xmm
where x is the combined thickness of the wall bracket and washer
Fasten force 97.36-177.01in-Ib. (11-=20 N-m)
'y cAuTioN

Do not over-tighten the screws.

NOTE
SMART recommends M8 x 30 mm mounting screws for standard installations where the
total wall mount bracket and washer thickness is less than 7 mm.

« Because the receptacles might not be easily accessible after the installers mount the
interactive flat panel, consider connecting cables for power, computers and other devices
while the interactive flat panel is still in its packaging (see Connecting power and devices on
page 15).

« Before turning on the interactive flat panel for the first time, clean the camera windows and
reflective tape following the instructions in Cleaning the camera windows and reflective tape
on page 26.

Mounting the interactive flat panel
vertically

The interactive flat panel is designed for vertical mounting (90° relative to the
floor plus or minus 15° for tolerance). SMART doesn’t support mounting the
interactive flat panel at other angles.

Choosing a location

Consider the following when choosing a location for the interactive flat panel:
« Do notinstall the interactive flat panel in a location where a door or gate could hit it.

« Do notinstall the interactive flat panel in an area where it will be subjected to strong vibrations

or dust.

12 smarttech.com/kb/170814
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MOUNTING THE INTERACTIVE FLAT PANEL

Choose a location that’s far from bright light sources, such as windows and strong overhead
lighting. IR lighting can cause issues with the performance of the cameras and can lead to

unintentional or missed touches.
Do notinstall the interactive flat panel near where the main power supply enters the building.

Ensure adequate ventilation or provide air conditioning around the interactive flat panel so
that heat can flow away from the unit and the mounting equipment.

If you mount the interactive flat panel in a recessed area, leave at least 4" (10 cm) of space
between the interactive flat panel and the recessed walls to enable ventilation and cooling.

Choosing a height
Consider the general height of the user community
when you choose the height for the

interactive flat panel.
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Connecting power and devices

CONNE IO PANE 16
CoNNECHING POW BT il 17
Connecting the r00M COMPULET . e e e 17
Connecting cables fora guest laptop ... .. .. 18
Connecting external Speakers ... il 18
Using the USB receptacle ... . 18

This chapter describes connecting the interactive flat panel to power, computers and other
devices.
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Connector panel

The following diagram and table present the connectors on the interactive flat panel:

A

@
[

g
]

ooooo

ooooo

ooooo
ooooo

ooooo

ooooo

ooooo

ooooo

ooooo
ooooo

ooooo

No. Connector Connectsto Notes (if any)

1 RS-232 Room control system See page 43.

2 USB Micro-B [N/A] This connectoris a service port.

3 Stereo 3.5 mm External speakers See page 18.

4 USB Type-B Guest laptop (touch) See page 18.

5 HDMI (HDMI) Guest laptop (video) See page 18.

6 Stereo 3.5 mm [N/A] This connector is not available for

SMART Board 8000i-G5-SMP series
interactive flat panels.

7 HDMI (OPS/HDMI2) Room computer (video) See page 17.

8 USB Type-B Room computer (touch) See page 17.

16 smarttech.com/kb/170814
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Connecting power E—
Connect the supplied power cable from the AC .
power inlet on the bottom of the interactive flat panel

to a power outlet.

NOTE
Refer to the interactive flat panel’s specifications for power requirements and power
consumption information (see Resources for decision makers on page 9).

Connecting the
room computer

Using USB and HDMI cables, connect the room
computer to the appropriate connectors on the

interactive flat panel.

NOTES

o You can use the interactive flat panel with up to two USB-XT extenders.

o Ifyouuse a CAT 5 USB extender, the maximum length of the Cat 5 cable is 52' (16 m).
Press the Input Select button EI on the front control panel until the input source is OPS/HDMI2.

NOTE

If the I/O extension module is installed, three values appear when you press the Input Select
button: HDMI, OPS/HDMI2 and DisplayPort. DisplayPort is not an available input for SMART Board
8000i-G5-SMP series interactive flat panels.

17 smarttech.com/kb/170814
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Connecting cables for a
guest laptop

You can install cables that enable users to connect a
guest laptop to the interactive flat panel from another

location in the room, such as on a conference table.

By installing these cables, you make use of
connectors that might not be accessible when the interactive flat panel is wall-mounted.

Connect USB and HDMI cables to the appropriate connectors on the interactive flat panel. You can
then run the cables across floors or behind walls to the conference table.

PN WARNING

Ensure that any cables that cross the floor to the interactive flat panel are properly bundled and
marked to avoid a trip hazard.

Connecting external
speakers

The interactive flat panel includes two 10 W speakers.
However, you can connect external active speakers

using the stereo 3.5 mm connector.

Using the USB receptacle

Users can connect a USB drive or device to the USB
Type-A receptacle on the bottom-left corner of the
interactive flat panel, and then use the USB drive to

open and save files to the room computer.

18 smarttech.com/kb/170814
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Turning on the interactive flat panel and room computer for the firsttime ..._........................ 19
Installing SMART SOftwWare ..l 20
Running the SMART Connection Wizard ... ... i 20

This chapter explains how to set up the interactive flat panel and room computer after mounting
the interactive flat panel and connecting power and devices.

Turning on the interactive flat panel and
room computer for the first time

After connecting the room computer to the interactive flat panel (see Connecting the
room computer on page 17) and mounting the interactive flat panel (see Mounting the
interactive flat panel on page 11), you can turn on both devices.

. To turn on the interactive flat panel and room computer for the first time
1. Turn onthe room computer.

2. Turnonthe interactive flat panel by flicking the power switch beside the AC power inlet to the
ON (l) position.

3. Pressthe Standby button @ on the front control panel.

19 smarttech.com/kb/170814



CHAPTER4
SETTING UP THE INTERACTIVE FLAT PANEL AND ROOM COMPUTER

Installing SMART software

Download and install SMART software on the room computer to take full advantage of the

interactive flat panel’s features.

. To download and install SMART software

1.

> w

Go to smarttech.com/downloads.

Scroll to the SMART Meeting Pro software section.

Click Choose a version, and then select the most recent version.

Click Download.

Follow the on-screen instructions to save the installer to a temporary location.
Double-click the installer.

Follow the on-screen instructions to install SMART software.

Running the SMART Connection Wizard

After turning on the interactive flat panel and room computer for the first time and installing SMART

software, run the SMART Connection Wizard to calibrate and orient the interactive flat panel.

IMPORTANT

You must calibrate the interactive flat panel before using it.

. To run the SMART Connection Wizard

1.

20

Access the SMART Connection Wizard by opening SMART Settings (see
Opening SMART Settings on page 22).

Click Connection Wizard.
The SMART Connection Wizard appears.

Select the interactive flat panel from the list of connected SMART interactive products, and
then click Next.

Select Product is being set up for the first time, and then click Next.

Follow the on-screen instructions to calibrate and orient the interactive flat panel for the
first time.

smarttech.com/kb/170814
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Chapter 5
Maintaining the
interactive flat panel

Resetting the interactive flat panel
Maintaining the interactive flat panel software and firmware

Maintaining the interactive flat panel hardware

Removing and transporting the interactive flat panel

Opening SMART Settings
Updating firmware
Updating software

Orienting the interactive flat panel
Calibrating the interactive flat panel

Checking the interactive flat panel installation
Cleaning the SCreen .
Cleaning the camera windows and reflective tape
Cleaning the presence detection sensor

Maintaining ventilation

Preventing condensation
Maintaining pens

Removing the interactive flat panel

Transporting the interactive flat panel

This chapter describes common maintenance procedures for the interactive flat panel.

Resetting the interactive flat panel

You can reset the interactive flat panel using the front control panel.

. To reset the interactive flat panel

21

Press the Standby button J on the front control panel.

A message appears on the screen, prompting you to either press the button again to enter
Standby mode or press and hold the button to reset the interactive flat panel.

smarttech.com/kb/170814
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2. Pressand hold the Standby button J until the screen turns black.

The interactive flat panel resets, and then your computer’s logon screen or desktop appears
on the interactive flat panel.

Maintaining the interactive flat panel software
and firmware

This section describes common maintenance procedures for the interactive flat panel software
and firmware.

Opening SMART Settings

Several maintenance and troubleshooting procedures in this guide are accessible through
SMART Settings.

. To open SMART Settings on Windows 7 operating system
Select Start > All Programs > SMART Technologies > SMART Tools > SMART Settings.

SMART Settings appears.

. To open SMART Settings on Windows 8 operating system
1. Openthe Apps screen.
2. Press SMART Settings.

SMART Settings appears.

Updating firmware

The interactive flat panel uses firmware on its processor. Updates to SMART software could
include a firmware update in the form of a downloaded firmware executable file. When the
interactive flat panel detects this executable file, you're prompted to run the file to update the

firmware.

' cauTtioN

o Only a system administrator should update interactive flat panel firmware.

« Only one interactive flat panel can be connected to the computer during the firmware
update.

« Do not disconnect the interactive flat panel from your computer during the firmware update.
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« Do nottouch the interactive flat panel’s screen or input button during the firmware update.

o Do not turn off your computer or the interactive flat panel during the firmware update.

. To update firmware

1. Make sure the interactive flat panel is connected to your computer.

2. Browse to and start the firmware updater at the following location:

Operating system Location

Windows (32-bit)  C:\Program Files\SMART Technologies\SMART Product Drivers\
SMARTFirmwareUpdater.exe

Windows (64-bit)  C:\Program Files (x86)\SMART Technologies\SMART Product Drivers\
SMARTFirmwareUpdater.exe

3. Follow the on-screen instructions using your computer’s mouse and keyboard. Don’t touch the
interactive flat panel’s screen.

4. Selectthe check box forthe SMART product you want to update, and then click Next.
A progress bar appears.

5. When the installation is complete, calibrate the interactive flat panel (see Calibrating the
interactive flat panel on the next page).

Updating software

SMART Product Update (SPU)is included in SMART software (see Installing SMART software on
page 20). SPU periodically checks for updates to the SMART software posted on the SMART
website. You can configure SPU to prompt users to install updates or to install updates
automatically.

NOTE
If you didn’t install SPU, you can download updates to SMART software from

smarttech.com/downloads.

Orienting the interactive flat panel
If the pointer appears a distance from the actual contact when you touch the screen, orient the
interactive flat panel.

NOTE

You can use your finger or a pen to orient the interactive flat panel.
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. To orient the interactive flat panel

1.

2.

Open SMART Settings (see Opening SMART Settings on page 22).
Press Orient.

Press the red targets as they appear. Hold your finger or the tip of the pen at the center of
each target, and then lift the pen or finger. When you lift the pen or finger, the target moves to

the next orientation point.

IMPORTANT
Hold the pen perpendicular to the screen.
Continue until you've pressed all the targets.
The orientation window closes.

If orientation doesn’t correct inaccurate touch, calibrate the interactive flat panel (see
Calibrating the interactive flat panel below).

Calibrating the interactive flat panel
Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser and

your finger on the interactive surface, and then send the information to the SMART software, which
interprets this information as mouse clicks, digital ink or an eraser in the appropriate location.
Calibration determines the position and angles of the cameras to accurately identify the location of

touches on the interactive flat panel.

IMPORTANT

If an error message appears while you are calibrate the interactive flat panel, contact

SMART Support (smarttech.com/support/entsupport).

. To calibrate the interactive flat panel

1.

2.

24

Open SMART Settings (see Opening SMART Settings on page 22).
Press SMART Hardware Settings.

If more than one SMART product is connected to your computer, select the
interactive flat panel.

Select Advanced Settings from the drop-down list.
Press Calibrate.

The calibration screen appears. This can take a few moments.
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10.

Press the red target with the tip of a pen. Hold the tip at the center of the target until the target
turns green, and then lift the pen.

The target moves to the next location.
NOTE
You can calibrate a target again by pressing the LEFT ARROW key on your keyboard.

Continue pressing targets until the second calibration screen and a grid appears.

An example appears briefly to demonstrate how to draw across the screen to calibrate the
interactive surface.

Use a pento draw a spiral horizontally across the grid. As you draw, the ink is blue. As you
complete each square, the square becomes green.

When all the squares are green, a progress bar appears.

When the progress bar is full, the interactive flat panel displays the message
Calibration successful.

Orient the interactive flat panel (see Orienting the interactive flat panel on page 23).

Maintaining the interactive flat panel hardware

With proper maintenance, the interactive flat panel hardware will provide years of use.

Checking the interactive flat panel installation
Inspect the interactive flat panel installation frequently to ensure that it remains securely installed.

« Check the mounting location for signs of damage or weakness that can occur over time.

« Check forloose screws, gaps, distortions or other issues that could occur with the mounting

hardware.

If you find an issue, contact a professional installer.

Cleaning the screen
Follow these instructions to clean the interactive flat panel screen without damaging its anti-glare

coating or other product components.

'y cauTioN
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« Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on

the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

smarttech.com/kb/170814



CHAPTERS
MAINTAINING THE INTERACTIVE FLAT PANEL

« Do not rub the screen with a dense or rough material.
o Do not apply pressure to the screen.

« Do not use cleaning solution or glass cleaner on the interactive flat panel screen, because
they can deteriorate or discolor the screen.

« Avoid touching the reflective tape between the screen and the frame, and ensure that this
strip stays dry. Damage to this strip affects touch interactivity.

. To clean the screen
1. Turn off the room computer.
2. Pressthe Standby button D on the front control panel twice.
3. Turnthe interactive flat panel off by flicking the power switch beside the AC power inlet.

4. Wipe the screen with a lint-free, non-abrasive cloth.

Cleaning the camera windows and reflective tape

The interactive flat panel’s DViT technology uses four cameras in the corners of the frame and the
reflective material between the screen and the frame. Dust buildup on the camera windows or
reflective tape can impair touch performance.

Inspect these areas regularly for dust, and clean them if any obvious dust buildup has occurred.

'Y cauTtionN

o Do not use compressed air to clean the camera windows or borders.
« Do not use water, chemicals or cleaning agents.

« Applying too much pressure when cleaning the tape or cameras can damage the tape and

cause performance issues or errors.

. To clean the camera windows and reflective tape

1. Using a clean lint-free cloth, gently wipe the camera windows in the top corners and the
reflective tape along the top of the interactive flat panel screen.

2. Gently wipe the reflective tape along the sides of the interactive flat panel screen.

3. Gently wipe the camera windows in the bottom corners and the reflective strip across the
bottom of the interactive flat panel screen.
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Cleaning the presence detection sensor
The interactive flat panel has a presence detection sensor on its bottom frame (see Presence
detection sensor on page 7).

Inspect the sensor regularly for dust and gently wipe it using a clean lint-free cloth if dust buildup
has occurred.

'y cauTioN

Do not use compressed air, water, chemical agents or cleaning agents to clean the sensor.

Maintaining ventilation
The interactive flat panel requires proper ventilation. Dust buildup in the ventilation holes
compromises cooling and leads to product failure.

« Clean accessible ventilation holes monthly with a dry cloth.

« Use avacuum cleaner with a narrow hose end fitting to clear the back ventilation holes
regularly. You might have to remove the interactive flat panel from the wall. For more
information on removing the interactive flat panel, sese Removing the interactive flat panel on
the next page.

7' cauTtionN

Avoid setting up or using the interactive flat panel in an area with excessive levels of dust,
humidity or smoke.

Preventing condensation
The interactive flat panel screen contains layers of glass that can collect condensation, especially
in the following conditions:

« Temperature extremes with high humidity

« Rapid changes in humidity, which can occur when you operate the product near water (such as
a pool, kettle or air conditioner ventilator)

« Direct exposure to sunlight

. To evaporate condensation from the interactive flat panel
1. Remove the humidity source from the interactive flat panel, if possible.

2. Turn off the interactive flat panel.
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3. Remove any moisture from the interactive flat panel with a smooth, dry cloth.

4. Leave the interactive flat panel turned off for 48 hours.

Maintaining pens

To prevent damage to the interactive flat panel’s anti-glare coating, replace a penif its nib
becomes worn. You can purchase replacement pens from the Store for SMART Parts

(see smarttech.com/Support/PartsStore).

Removing and transporting the
interactive flat panel

On occasion, you might need to remove the interactive flat panel from its current location and
transport it to another location.

Removing the interactive flat panel
To remove the interactive flat panel safely, use two or more professional installers.

PN WARNING

« Do not attempt to move the interactive flat panel by yourself. The interactive flat panel is
very heavy.

« Do not move the interactive flat panel by connecting a rope or wire to the handles on the
back. The interactive flat panel can fall and cause injury and product damage.

IMPORTANT

Follow the instructions included with the floor stand or mounting hardware.

. To removetheinteractive flat panel
1. Turn off the room computer.
2. Pressthe Standby button D on the front control panel twice.
3. Turn off the interactive flat panel by flicking the power switch beside the AC power inlet.

4. Remove all accessible cables and connectors.
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5. Liftthe interactive flat panel from its mounting location.

PN wARNING

Do not place the interactive flat panel on a sloping or unstable cart, stand or table, because
the interactive flat panel could fall, resulting in injury and severe product damage.

' cauTioN

Do not leave the interactive flat panel face up, face down or upside down for an extended
period of time, because it could cause permanent damage to the screen.

6. Remove the mounting brackets.

Transporting the interactive flat panel

Save your original packaging so that you can repack the interactive flat panel with as much of the
original packaging as possible. This packaging was designed to provide the best possible
protection against shock and vibration. If the original packaging isn’t available, you can purchase
the same packaging directly from your authorized SMART reseller (smarttech.com/where).

'\ cauTtionN

Transport the interactive flat panel only in original or replaced packaging. Transporting the
interactive flat panel without correct packaging can lead to product damage and voids the
warranty.
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Using the SMART Connection Wizard ... . 35
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This chapter helps you solve simple issues that can occur with the interactive flat panel. If issues
persist or aren’t covered in this chapter, contact SMART Support
(smarttech.com/support/entsupport).

Locating the interactive flat panel serial number

When you contact SMART Support, you might be asked to provide the interactive flat panel
serial number. The serial numberis located in two places:

e The on-screendisplay menu (see Serial Number on page 40)

o Underneath the bottom frame

Resolving common issues using the indicator light

The Standby button on the front control panel also functions as an indicator light. You can use the
indicator light to resolve common issues with the interactive flat panel. For more information, see
Front control panel on page 5.
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Resolving presence detection issues

Use the following table to resolve presence detectionissues:

Symptom

Cause

Solution

The interactive flat panelisn’t
turning on.

Presence detection isn’t enabled.

Enable presence detection (see page 40).

Thereisn’t enough difference
between the room temperature
and human body temperature.

Reduce the room temperature.

You aren’t within 16' (5 m) of the
interactive flat panel.

Move closer to the interactive flat panel or
make bigger motions.

Thereis glass, acrylic or similar
material between you and the
interactive flat panel.

Remove the material.

The interactive flat panelisn’t
turning off when people leave the
room.

Presence detection isn’t enabled.

Enable presence detection (see page 40).

The interactive flat panelis turning
on after it has been turned off.

The re-enable time is too short to
allow you to exit the room before
the sensor starts detecting motion
again.

Increase the re-enable time (see
page 40).

Sunlightis hitting the
interactive flat panel.

Close any blinds or shades.

There s glass, acrylic or similar
material between you and the
interactive flat panel.

Remove the material.

The interactive flat panelis turning
on when people aren’t present.

There’s a sudden temperature
change in the room (for example,
humidifier emission, air
conditioning or heating system).

Remove the source of major temperature
fluctuation.

Sunlightis hitting the
interactive flat panel.

Close any blinds or shades.

The interactive flat panelis turning
off when people are present.

Over time, presence detection
averages the room temperature
so people’s body temperature
becomes part of the ambient
temperature.

Increase the time before the
interactive flat panel automatically turns
off (see page 40).
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Resolving image issues

Use the following table to resolve image issues:

Symptom

Cause

Solution

The image is too light, too dark or
has poor image quality.

The interactive flat panel’s picture
settings might be setincorrectly.

Adjust the Picture options (see Picture on
page 38).

There is a persistentimage on the
screen.

Animage was displayed for too
long.

« Turn off the interactive flat paneland
leave it turned off for as long as the image
was on the screen.

o Setupscreen savers on any connected
computers to prevent persistentimages.

There are other image issues.

Return all settings to their default values

(see page 40).
Resolving touch issues
Use the following table to resolve touch issues:
Symptom Cause Solution

When you touch the screen, the
pointer appears in the wrong
location.

You aren’ttouching the screen ata
rightangle.

For more information, see Touching and
drawing on your SMART Board interactive
whiteboard is inaccurate
(kb.smarttech.com/?q=13976).

The interactive flat panelisn’t
oriented.

Orient the interactive flat panel (see
page 23).

An area ofthe screen doesn’t
respond to your touch, or when
you draw digitalink, the lines are
broken.

Something is blocking the cameras.

Ensure nothing is taped to the screen.

Something is in the reflective tape
channel.

Remove items from the reflective tape
channel.

Your finger or pen is skipping as
you draw. This is most common on
the upstroke.

Use consistent pressure while drawing
digitalink.

Bright lights are interfering with the
cameras.

Close blinds or shades or dim all halogen
lights and LEDs.

The cameras require calibration,
possibly because of a temperature
change in the room.

Calibrate the interactive flat panel (see
page 24).

You can interact with screen
elements by touching them, but
you can’t write or draw using the
pens.

The cameras require calibration,
possibly because of a temperature
change in the room.

Calibrate the interactive flat panel (see
page 24).
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Resolving connected computer issues

Use the following table to resolve connected computerissues:

Symptom

Cause

Solution

The connected computer’s display
is too large,too small or doesn’t
completely fillthe screen.

The connected computer’s video
resolution settings don’t match the
interactive flat panel’s native
resolution.

Setthe computer’s video resolution to
3840 x 2160 at 30 Hz. (Ifthe connected
computer can’t support this resolution,
consider 1920 x1080 at60 Hz as an
alternative.)

The connected computer’s screen
resolution is correct, but the image
is surrounded by black bars.

The connected computer’s video
cardis underscanning the image.

o Turn off or adjustthe
overscan/underscan feature in the video
card driver software until the image fits
the screen resolution. Refer to the
computer’s video card Help for more
information.

« Selectthe 4K UHD option from the video
card driver’s advanced menu (if available).

The video cable is of poor quality.

Replace the video cable with a better
quality video cable.

You’re using two connected video
cables.

+ Replace the two cables with one longer
cable.
OR

« Move the computer so thatit’s within a
single cable length of the
interactive flat panel.

The interactive flat panel’s native
resolution doesn’t match the
resolution on the computer’s
display adapter.

Check the resolution on the computer’s
display adapter and change the
interactive flat panel’s resolution to match.

The connected computer’s display
is unstable or unfocused.

The video connection is loose.

Secure the video cable to both your
computer and the interactive flat panel.

The video cable is of poor quality.

Replace the video cable with a better
quality video cable.

You’re using two connected video
cables.

« Replace the two cables with one longer
cable.
OR

« Move the computer so thatit’s within a
single cable length of the
interactive flat panel.

The connected computer’s video
display card is defective.

Connect a different computer to the
interactive flat panel. If this improves the
image quality, consider replacing the
video card in the original computer.

The SMART Board icon E doesn’t
appear.

SMART Product Driversisn’t
installed.

Download and install
SMART Product Drivers from
smarttech.com/downloads.

SMART Product Drivers isn’t
running.

Start SMART Product Drivers following the
steps in the Help.
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Symptom

Cause

Solution

Touch interactivity is slow.

The connected computer is
running too many applications.

Close some open applications.

The connected computer doesn’t
meet SMART requirements.

Upgrade the computer or replace it with
another computer that meets system
requirements.

You haven'tused a USB 2.0 cable
to connectthe interactive flat panel
to the computer.

Use a USB 2.0 cable and ensureit's
connected to the correct USB receptacle
(see page 17 or page 18).

There’s no sound when you play
an audio file.

The connected computer’s
playback device isn’t set correctly.

Ensure the connected computer’s
playback device is setas the

interactive flat panel (see the connected
computer’s documentation).

The interactive flat panel's audio
inputisn’tset correctly.

Ensure the interactive flat panel's audio
inputis setas the computer’s audio
connector (see page 39).

The connected computer is muted.

Turn off the mute setting.

The connected computer’s volume
is too low.

Turn up the volume on the computer.

The interactive flat panelis muted.

Turn off the mute setting using the front
control panel.

The interactive flat panel’s volume
is too low.

Turn up the volume using the front control
panel.

Using the SMART Connection Wizard

You can resolve a variety of issues using the SMART Connection Wizard found in SMART Settings.

. To usethe SMART Connection Wizard

1. Access the SMART Connection Wizard by opening SMART Settings (see
Opening SMART Settings on page 22).

2. Press Connection Wizard.

The SMART Connection Wizard appears.

3. Selectthe interactive flat panel from the list of connected SMART interactive products, and

then press Next.

4. Selectthe option that best describes the issue you’re encountering, and follow the on-screen

instructions.
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Using SMART Diagnostics

If you touch the interactive flat panel’s surface and nothing happens, if there is no digital ink, or if
the ink appears in some locations and not in others, use SMART Diagnostics to help identify and

resolve these issues.

IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Support.

. To check camera views

1.

2.

36

Open SMART Settings (see Opening SMART Settings on page 22).

Select About Software and Product Support > Tools > Diagnostics.

SMART Diagnostics opens.

Select View > SPNL-6000/SBID8000-G5 Bar.

The group box appears.

Press View.

The camera view screen appears.

Click Get image to display the four camera views. This could take a few moments.

If one of the camera views doesn’t appear, the camera is blocked or can’t locate the
reflective tape on the interactive flat panel’s inner frame.

NOTE

You can compare the camera view to examples of normal camera views.

Check the camera lens and ensure that nothing is blocking its view and that nothing is affixed
to the interactive surface.
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Changing settings in the on-screen display menu ... ... . 37
On-screendisplay Menu OptioNS . ... .. 38

You can access the on-screen display menu using the menu control panel located on the side of
the interactive flat panel.

No. Name

1 MENU

SET

[Up]

[Down]

[Left]

o |||l wWw|N

[Right]

Changing settings in the on-screen display menu

. To change settings in the on-screen display menu
1. Press the MENU button on the menu control panel.
The on-screen display menu appears.
2. Pressthe up and down arrows to highlight a menu, and then press SET.

3. Pressthe up and down arrows to highlight a menu option.
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4. Pressthe left and right arrows to change the menu option’s setting.

OR

Press the right arrow to open the menu option’s submenu. (Repeat steps 3 and 4 to change

settings in the submenu.)

5. Press MENU until the on-screen menu closes.

On-screen display menu options

Option Values Function Notes (if any)
Picture
» Picture Mode Standard Sets the picture mode Select User to customize
User brightness, contrast, sharpness
. and other Picture options.
Dynamic
Select one of the other values to set
brightness, contrast, sharpness
and other Picture options to default
values.
® Brightness 0-100 Sets the overall brightness of the You can modify this option only if

image and background

you select User in Picture Mode.

® Contrast 0-100 Sets the difference in brightness
between the lightest and darkest
parts of theimage.

You can modify this option only if
you select User in Picture Mode.

® BlackLevel 0-100 Sets the level of brightness in the
darkest parts of the image

You can modify this option only if
you select User in Picture Mode.

® Color 0-100 Sets the image color depth You can modify this option only if
you select User in Picture Mode.
® Sharpness 0-100 Sets the image sharpness Y ou can modify this option only if
you select User in Picture Mode.

» Color temperature Normal Sets the color temperature Select User to customize the

Warm amountofred,green andbluein

User the image.

Cool Select one of the other values to set
the amount of red, green and blue
in the image to default values.

® Red 0-100 Sets the amount of red in the You can modify this option only if
image you select User in Color
Temperature.
® Green 0-100 Sets the amount of greenin the You can modify this option only if
image you selectUser in Color
Temperature.
® Blue 0-100 Sets the amount of blue in the You can modify this option only if
image you select User in Color

Temperature.
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the current

Option Values Function Notes (if any)
® Movie Mode Off Sets the brightness, contrast, black
Low level, color and sharpness for
Middle movie watching
High
® Picture Reset [N/A] Resets all options in the Picture
menu to their default values
Sound
» SoundMode
® Treble L50-R50 Sets the high frequency sound
® Bass L50-R50 Sets the low frequency sound
> EQ
® 120 Hz 0-100 Sets the sound equalization at
120 Hz
® 500 Hz 0-100 Sets the sound equalization at
500 Hz
® 12kHz 0-100 Sets the sound equalization at
1.2 kHz
® 75kHz 0-100 Sets the sound equalization at
75kHz
® 12kHz 0-100 Sets the sound equalization at
12 kHz
® Balance L50-R50 Balances the left and right volume
® Audio Input [Depends on Sets the audio input source If HDMl is the current video input,

the available values are HDMI and

video input] USB.
If OPS/HDMI2 is the current video
input, the available values are
OPS Digitaland USB.
If DisplayPortis the current video
input, the available values are
DisplayPort and USB.
® Sound Reset [N/A] Resets all options in the Sound
menu to their default values
OsD
® Language [Languages] Sets the on-screen display menu’s
language
® OSD Turn Off Off Sets the time of inactivity before the
5seconds on-screen display menu turns off
10 seconds
15 seconds
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Option Values Function Notes (if any)
® OSD Reset [N/A] Resets all options in the OSD menu
to their default values
Setup
® Power Save On Enables or disables Power Save When Power Save mode is enabled
Off mode and thereis no video input, the
interactive flat panel displays
No Signal for 25 seconds before
turning off.
® Monitor ID 1-100 Specifies a unique ID for the
interactive flat panel
® FBC Control On Enables or disables the front
Off control panel
> Proximity On Enables or disables presence
Off detection
® Re-enable Time 1Min.—10Min. Sets how long the
interactive flat panel waits before
detecting motion again
® Auto Power Off 15Min.—240Min. | Sets how longthe
interactive flat panel waits before
turning off
® Video input detect On Enables or disables video input With video input detection, the
Off detection. interactive flat panel displays the
default video input (OPS/HDMI2)
when there are no computers or
other devices connected.
Video input detection is usefulin
scenarios where a user connects a
laptop to the interactive flat panel
for a meeting and forgets to return
to the default video input after
disconnecting the laptop.
® Lync®Room Reset [N/A] Resets options in allmenus to their
default values (for a
SMART Room System™ for
Microsoft® Lync)
® Setup Reset [N/A] Restores the setup settings to their
defaultvalue
® Factory Reset [N/A] Resets options in allmenus to their
defaultvalues
About
® ModelNumber [N/A] Displays the interactive flat panel’s
model number
® Serial Number [N/A] Displays the interactive flat panel’s

serialnumber
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Option Values Function Notes (if any)

® Scalar firmware version [N/A] Displays the interactive flat panel's
scalar frmware version

® Touch firmware version [N/A] Displays the interactive flat panel’s
touch firmware version

® OPS Information [N/A] Displays whether the I/O extension
module is installed

4 smarttech.com/kb/170814






Appendix B

Remotely managing the
interactive flat panel

Connecting and configuring a room control system ... ... . .. i 43
Connecting a computer to the interactive flat panel ... .. ... 44
Configuring the computer’s serial interface settings ... ... ... ... 44

PoWer MOAeS il 45

Room control system programming commands and reSponses . ... ... ... ... ..oi........ 45
Command INVeN Oy ..l 46

Viewing a list of available commands . ... .. 46
Identifying current values ... L 46
Assigning a specific value ... .. .. 46
Increasing or decreasing a value forasetting ...... . ... ... 46
Designating video control settings for a specific video input ...... ... ... ............... 46

COMMaANAS .. 47
P oW T STt . e 47
SOUIC L 48
AT = o 48
AUAIO 49
System iINformatioNn ... e 51

This appendix includes detailed instructions for setting up your computer or room control system
to remotely manage the interactive flat panel using an RS-232 serial interface.

Connecting and configuring a
room control system

Connect a computer to the room control input on the interactive flat panel to remotely select video
inputs, turn the interactive flat panel on or off and request information such as contrast, power state
and current settings.
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Connecting a computer to the interactive flat panel

. To connect a computer to theinteractive flat panel

Connect an RS-232 cable from the computer’s serial output to the room control input on the
connector panel.

IMPORTANT

Do not use a null modem cable. Use only a standard RS-232 cable.

Configuring the computer’s serial interface settings
Configure the computer’s serial interface before sending commands to the interactive flat panel.

. To configure the computer’s serial interface

1.

2.

44

Turn on the interactive flat panel.

Turn on the computer, and then start the serial communications program or terminal emulation
program.

Activate local echo.

Configure the serial interface settings using the following values, and then press ENTER.

Baud rate 19200
Data length 8
Parity bit None
Stop bit 1

A command prompt (>) appears on the following line, and the interactive flat panel can now
accept commands form the computer.

NOTE

If no message appears or an error message appears, the serial interface configuration isn’t
correct. Repeat steps 3 and 4.
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Power modes

The interactive flat panel has three power modes:
« On
« PowerSave
« Standby

All commands are available when the interactive flat panel is on. Some commands are available
when the interactive flat panel is in Standby mode.

Room control system programming commands
and responses

To access interactive flat panel information or to adjust interactive flat panel settings using the
room control system, type commands after the command prompt (>), and then wait for the
response from the interactive flat panel.

CORRECT

>get contrast
contrast=55

If you type a command that the room control system doesn’t recognize, you receive an invalid
command response.

Inthe example below, the userincluded an extra space in the contrast command.

INCORRECT

>set con trast=65
invalid cmd=set con trast=65

NOTES

Use ASCII formatted commands.
« Commands aren’t case-sensitive.
o Review each entry carefully before you press ENTER.

o Don’t send another command until you receive the response and the next command
prompt.
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Command inventory
The interactive flat panel responds to the commands listed in the tables on the following pages.

Viewing a list of available commands
You can view a list of available commands by typing ? at the command prompt and pressing
ENTER.

Identifying current values
Use the get command to identify values for a setting. This example shows how to get the
interactive flat panel’s contrast level.

>get contrast

contrast=55

Assigning a specific value
Use the set command to assign a value to a setting. This example sets the interactive flat panel’s
contrast level to 65.

>set contrast=65
contrast=65

Increasing or decreasing a value for a setting
You can also use the set command to increase or decrease a setting by a designated number. This
example increases the interactive flat panel’s contrast level by 5.

>set contrast +5
contrast=70

This example decreases the interactive flat panel’s contrast level by 15.

>set contrast -15

contrast=55

Designating video control settings for a specific video input

When you connect multiple video inputs to the interactive flat panel, you can designate different
settings for each video input. You can also specify the video input for which to identify or assign
settings.

NOTE

You must connect the video input to the interactive flat panel to identify or assign a value for it,
but the video input doesn’t need to be in use.
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In the example below, the user wants to identify the contrast for the HDMI1 video input.

>get contrast hdmil

contrast hdmil=65

In the example below, the user wants to set the contrast to 70 for the HDMI video input.

>set contrast hdmil=70

contrast hdmil=70

Commands

The following tables contain the commands for the interactive flat panel.

NOTE
The Standby mode column indicates whether the command is available while the
interactive flat panel is in Standby mode.

Power state
Use the following commands to identify power state settings.
Command Response Possible values Standby
mode
getintpowerstate intpowerstate=[Value] e ON Yes
« standby
« dpms
« novideo
« confirm
o proximitywait
+« welcome
get powerstate powerstate=[Value] e ON Yes
o Off
« standby

Use the following commands to assign power state settings.

Command Possible values Response Standby
mode
set powerstate [Value] e« =0n powerstate=[Value] Yes
o =Off
o =standby
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Source
Use the following commands to identify source settings.

Command Response Possible values Standby
mode
getinput input=[Value] o hdmil Yes
o ops/hdmi2
« displayport
getvideoinputs videoinputs=/Value] o hdmil Yes
o ops/hdmi2

« displayport

Use the following commands to assign source settings.

Command Possible values Response Standby
mode
setinput [Value] o =hdmil input=/Value] Yes
o =ops/hdmi2
« =displayport
e =next
Video
Use the following commands to identify video settings.
Command Response Possible values Standby
mode
getdisplaymode displaymode=[Value] « standard No
e user
« dynamic
get contrast contrast=[Value] 0-100 No
get brightness brightness=[Value] 0-100 No
gettint tint=/Value] 0-100 No
getsharpness sharpness=[Value] 0-100 No
get colortemp colortemp=[Value] « normal No
e warm
« cool
e user
getred red=[Value] 0-100 No
getgreen green=[Value] 0-100 No
getblue blue=[Value] 0-100 No
get blacklevel blacklevel=[Value] 0-100 No
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Use the following commands to assign video settings.

Command Possible values Response Standby
mode

set displaymode [Value] « =standard displaymode=[Value] No
« =user
o =dynamic

set contrast [Value] e +/[Incrementalvalue] contrast=/Value] No
e -[Incrementalvalue]
« =0-100

set brightness [Value] e +[Incrementalvalue] brightness=[Value] No
e -[Incrementalvalue]
« =0-100

settint[Value] e +[Incrementalvalue] tint=/Value] No
e -[Incrementalvalue]
« =0-100

setsharpness [Value] e +[Incrementalvalue] sharpness=[Value] No
e -[Incrementalvalue]
« =0-100

set colortemp [Value] « =normal colortemp=[Value] No
¢ =warm
e =cool
« =user

setred [Value] e +[Incrementalvalue] red=[Value] No
e -[Incrementalvalue]
« =0-100

setgreen [Value] o +[Incrementalvalue] green=[Value] No
e -[Incrementalvalue]
« =0-100

setblue [Value] o +[Incrementalvalue] blue=[Value] No
e -[Incrementalvalue]
« =0-100

set blacklevel [Value] e +[Incrementalvalue] blacklevel=/Value] No
e -[Incrementalvalue]
« =0-100

set picturereset [Value] =yes picturereset=[Value] No

Audio
Use the following commands to identify audio settings.
Command Response Possible values Standby
mode
getvolume volume=[Value] 0-100 No
get mute mute=[Value] e ON No
o oOff
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Command Response Possible values Standby
mode
getaudioinput audioinput=/Value] « usbaudio No
« HDMI
« DisplayPort
« OPSdigital
gettreble treble=[Value] 0-100 No
getbass bass=[Value] 0-100 No
getaudioeq120 audioeq120=/Value] 0-100 No
getaudioeq500 audioeq500=[Value] 0-100 No
getaudioeq1200 audioeq1200=/Value] 0-100 No
getaudioeq7500 audioeq7500=/Value] 0-100 No
getaudioeq12k audioeq12k=[Value] 0-100 No
getbalance balance=[Value] 0-100 No
Use the following commands to assign audio settings.
Command Possible values Response Standby
mode
setvolume [Value] e +/[Incrementalvalue] volume=[Value] No
e -[Incrementalvalue]
« =0-100
set mute [Value] e« =0n mute=[Value] No
o =Off
setaudioinput[Value] « =usbaudio audioinput=/Value] No
« =HDMI
« =DisplayPort
« =OPSDigital
settreble [Value] e +[Incrementalvalue] treble=[Value] No
e -[Incrementalvalue]
« =0-100
setbass [Value] e +[Incrementalvalue] bass=[Value] No
e -[Incrementalvalue]
« =0-100
setaudioeq120 [Value] =0-100 audioeq120=[Value] No
setaudioeq500 [Value] =0-100 audioeq500=[Value] No
setaudioeq1200 [Value] =0-100 audioeq1200=[Value] No
setaudioeq7500 [Value] =0-100 audioeq7500=[Value] No
setaudioeq12k [Value] =0-100 audioeq12k=[Value] No
setbalance [Value] e +[Incrementalvalue] balance=[Value] No
e -[Incrementalvalue]
« =0-100
setsoundreset [Value] =yes soundreset=[Value] No
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System information

Use the following commands to identify system information settings.

Command

Response

Possible values

Standby
mode

get autopoweroff

autopoweroff=[Value]

15-240

No

get fwverscr

fwverscr=[Value]

[Scalar version firmware
number]

Yes

get fwvertouch

fwvertouch=[Value]

[Touch controller frmware
version number]

Yes

getserialtouch

serialtouch=[Value]

[Touch controller serial
number]

get opsinfo

opsinfo=[Value]

OPS
NO OPS

getlanguage

language=[Value]

English
Arabic
Danish
German
Spanish
Finnish
French
Hebrew
Italian
Dutch
Norwegian
Portuguese
Russian
Swedish
Turkish
Chinese_sim

getmodelnum

modelnum=[Value]

[Model number]

getserialnum

serialnum=[Value]

[Serialnumber]

get proximityinstalled

proximityinstalled=/Value]

yes
no

get proximity

proximity=/Value]

on
off

Yes

get proximityreenable

proximityreenable=[Value]

1-10

Yes

get proximitydetected

proximitydetected=/Value]

yes
no

get monitorid

monitorid=[Value]

1-100
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Use the following commands to assign system information settings.

Command

Possible values

Response

Standby
mode

set autopoweroff [Value]

+[Incremental value]
-[Incremental value]
=15-240

autopoweroff=[Value]

No

setfactoryreset [Value]

=yes

factoryreset=[Value]

setlanguage [Value]

=English
=Arabic
=Danish
=German
=Spanish
=Finnish
=French
=Hebrew
=ltalian
=Dutch
=Norwegian
=Portuguese
=Russian
=Swedish
=Turkish
=Chinese_sim

language=[Value]

set proximity [Value]

=on
=off

proximity=[Value]

Yes

set proximityreenable [Value]

=1-10

proximityreenable=[Value]

Yes

set monitorid [Value]

+[Incremental value]
-[Incremental value]
=1-100

monitorid=/Value]

setlyncroom [Value]

=reset

lyncroom=[Value]

settouchdetected [Value]

=yes

touchdetected=/Value]
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Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment (WEEE)
Electrical and electronic equipment contain substances that can be harmful to the

environment and to human health. The crossed-out wheeled bin symbol indicates that E
products should be disposed of in the appropriate recycling stream and not as regular

waste.

More information

See smarttech.com/compliance for more information.

53 smarttech.com/kb/170814


http://www.smarttech.com/compliance




Index

A

air conditioning 13, 27
angle (mounting) 12
aspectratio 5
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Diagnostics See SMART Diagnostics
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documentation 9
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factory reset 40
firmware updates 22
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reset 21
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